       DFC CONTROL TERMINAL SOFTWARE

 VERSION 2.05
        Installing the DFC Control Terminal


Insert the installation disk or the CD in the appropriate disk drive on your PC. The installation should begin automatically. If it is does not, issue the Windows “Run…” command and type the following command:


<disk>: \ SETUP


The installation program will begin and guide you through the installation process.                 


Requirements


Your PC should have at least one free COM port and be running one of the following:

1. Windows 2000

2. Windows Me

3. Windows NT

4. Windows XP

  SOFTWARE OVERVIEW

This manual contains information designed to familiarize you with the features of the DFC mass flow controllers, and also with the DFC Control Terminal software.

DFC Mass Flow Controller 

The DFC Digital Mass Flow Controller provides both digital and analog interfaces. The analog interface provides 0 to 5 Vdc, 0 to 10Vdc or 4 to 20 mA inputs and outputs for flow reading and set point.  The digital interface operates via RS-485 or optional RS-232 standard and provides full access to applicable internal data and various functions including:

-Sending Set Point 

-Receiving Current Flow

-Valve Control

-Alarm Settings

-Totalizer Settings

-Engineering Units Selections

-Gas Table Selections

-Auto Zero

-PID Auto Tune 

DFC Control Terminal Software 

The DFC Control Terminal software shipped with DFC26/36/46 mass flow controllers allows you to send the set point to the controller and receive back the current flow rate in the desired engineering units, control mode of the proportional solenoid valve, calibrate ADC/DAC and gas flow table, change the DFC’s address, operate the Totalizer and hi/low alarm, execute custom programs (ramping) up to 12 steps, record flow rate directly and continuously to the disk, while monitoring on the screen. It also features a general purpose communication terminal, which can be used for communication with any RS-232 compatible device. The software provides an active Request To Send (RTS) signal. The RTS line is active (high) while the host computer is transmitting data. RTS will be inactive (low) while the host computer is receiving data.

Connecting the DFC mass flow controller to your computer

In order to communicate with your PC, at least three-wire connections have to be made.

For the RS-232 option:

Connect the DFC TX line (pin 11 on 25 pin “D”-connector) to the PC COM port RX line (pin 2 on 9 pin “D” connector).

Connect the DFC RX line (pin 24 on 25 pin “D”-connector) to the PC COM port TX line (pin 3 on 9 pin “D” connector).  

Connect the DFC GND line (pin 20 on 25 pin “D”-connector) to the PC COM port SG line (pin 5 on 9 pin “D” connector).

For the RS-485 option:

The RS485 converter/adapter has to be configured for: multi-drop, 2 wire, half duplex mode. The transmitter circuit has to be enabled by TD or RTS (depending on what is available on the converter/adapter). Settings for the receiver circuit should usually follow the selection made for the transmitter circuit in order to eliminate Echo. 

Pin 11 (-) of the “D” connector has to be connected to T- or R- on the RS-485 converter/adapter. 

Pin 24 (+) of the “D” connector has to be connected to T+ or R+ on the RS-485 converter/adapter.

Pin 20 (Common) of the “D” connector has to be connected to GND on the RS-485 converter/adapter.

Apply power to the DFC before attempting to communicate with the PC.

See the DFC26/36/46 operating manual for details regarding power connections.  

Configuring serial interface

After you have completed all hardware and software installations and connected your signals, you are ready to communicate with the device.

Start the DFC Control Terminal software. To do this:

click the Start button on the taskbar, point to Programs, point to DFC Control Terminal (or whatever you named the group window during installation), and click DFC Control Terminal shortcut. 

m
If communication parameters of the remote DFC device do not follow the default program settings, or the device is not connected to the host communication port, when first starting  the program;  user can experience two or three Communication ERROR  warnings.  
        
        The first menu selection to make will usually be the CommPort menu selection. CommPort/Properties is required to configure the host computer serial port communications parameters to those values used by a remote DFC device. The selectable communications parameters are: communications port COM1- COM16, baud rate, error check status, and flow control. These parameters must be set properly before attempting to communicate with the DFC mass flow controller.

Initially on the first program startup the default communications parameters are: RS-485 interface, communications port COM1, 9600 baud, no error check and Flow Control - None.
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 All DFC mass flow controllers shipped from the factory with RS-485 interface have default address “11”. For the RS-232 option of the controller the address is not required, since only one device can be connected to the host RS-232 interface.

When using RS-485 interface with multiple device configuration, it is recommended to connect one device at the time and check DFC response. If the device with default address “11” is talking to the host, the next step is changing the address in order to make sure all devices on the RS-485 bus have unique addresses (see Changing Device Address).   

Set required parameters by:


Pointing to CommPort menu and dragging down to Properties…
The Timing tab is used to define Scanning  interval (ms) and Log Recording  interval (ms).

For RS-232 interface choose “Single Device Operation” and for RS-485 - “Multiple Device Operation”.

Scanning interval defines how frequently data will be updated on the screen.

Log Recording interval defines how frequently data will be written to the file.

Make desired selection and click OK or press ENTER key. 

Once the CommPort/Properties parameters have been selected, they remain in effect after the program is closed. 

Configuring device properties

 Initially on the first program startup only five devices exist in the system and they are configured with default parameters:

Device Number:


1           2             3            4             5

Name:



       DFC #1, DFC #2, DFC #3, DFC #4, DFC #5

Address:



11        12           13          14          15 

Gas Table:



1

Engineering Units:


%F.S.

Full Scale Flow Range [SLPM]:
100 

Input Mode:



Analog

Valve Mode:



Closed

Auto Zero:



Disabled

Totalizer Mode:


Disabled 

Start Total @ Flow [%F.S.]:

2

Stop Total Volume [%F.S. * Sec.]:
10000

Alarm Mode:



Disabled 

Alarm High [%F.S.]:


2

Alarm Low [%F.S.]:


2

Alarm Update Rate [Sec.]:

1

Relay #1 Status:


No Action

Relay #2 Status:


No Action

K Factor (N2):



1

Communication:


Enabled, Disabled, Disabled, Disabled, Disabled,

Since only one device can be connected to an RS-232 interface, it is normally not necessary to add an additional device to the system. User can modify device properties for a particular application.

 To modify device properties:

1. Point to Device menu and drag down to Properties…

2. Enter the desired parameters in the Device Properties dialog box.


3. Click OK button.

Keep in mind that Device Address has to be unique for each device in the system. The software automatically checks Device Address for duplication and displays a warning window when a duplication conditions exist.       

For systems with RS-485 interface it may be necessary to add or delete a device from the system. Current version of the software supports up to 64 device for RS-485 interface.

To add a device:


1. Point to Device menu and drag down to Properties…

2. Click ADD button.

3. Enter a number for the new device in to the dialog box (1-64 are allowed). The DFC Control Terminal automatically checks the device number for duplication and displays a warning window when duplication conditions exist. Press the OK button.

4. Enter Address for a new device in to the dialog box (two characters). The DFC Control Terminal automatically checks the device Address for duplication and displays a warning window when duplication conditions exist. Press the OK button.

The currently active device number will be displayed in the upper right field, and in the combo box. The new device will be configured with default parameters. All device properties for new device can be modified for particular application.  
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 In the General Section of the Device Properties do not modify the Device Status option (live Device Status – Disabled). You can enable a device only after the hardware address will follow the software address. This will eliminate the Communication Warning Message while the hardware address of the DFC is not properly configured. When Device Status is “Disabled” the DFC Control Terminal prevents any communication activity with a particular device. 

5. Click the OK button to close the Device Properties dialog box, and save the new parameters.

To delete a device:  


1. Point to Device menu and drag down to Properties…

2. Click on device number combo box. The list with available device numbers    will be displayed. Choose device, which has to be deleted.

3. Click REMOVE button.  


4. Click the OK button to save device properties

.

Changing Device Address

All DFC mass flow controllers shipped from the factory with RS-485 interface have the default address “11”. In order to change a remote device address only one device has to be connected to RS-485 bus. Power up DFC which required changing of the RS-485 address and check communication with Read Flow command:

Point to the Commands menu and drag down to Flow. Device will responds to the host   with the current reading.  

m 
In order to monitor the communication transmission menu CommPort / Monitor has to be  selected. This will activate the communication monitor at the bottom of the screen. 

If no device response is received during 2 seconds or an error message is returned from the connected DFC, the program will prompt with a communications error message.

If you are getting an error message, check the device address value, and your physical connection (communication cable). It is also possible that you are connected to a different COM port number (check Communication Properties). Once connection is established (!11,0.00 is received back from the device), you are ready to proceed with address changing. 

Point to the Query menu, drag down to Back Door…and click on Open. This will open Query menu for user’s access. Next, point to the Query menu, drag down to Memory and click Write. Writing to EEPROM Memory Dialog box will appear. Enter  “7” then “,” and desired two hexadecimal characters address and press ENTER, or click the OK button (for example: 7,16). New address will be written to the remote device EEPROM memory (device will response with: !11,MW,7,16). Once RS-485 address is changed the device will reply only to the new address (make corresponding settings in the Device / Properties).

Getting Flow Reading From Device 

The Commands/Flow menu selection is used to tell the DFC to transmit it’s current reading one time,- in currently selected Engineering Units. Before attempting to transmit data from the device, the correct device number has to be chosen from the Current Device combo box. 

To change Current Device number:

1. Click the Current Device combo box list arrow. List of available devices will appear. 


2. Click on the desired device number. 

m 
When a new device is selected and Device Status is “Enabled” the host computer initiated the series of  queries to the remote DFC in order to synchronize settings.

To Read Flow Once:


 Point to the Commands menu and drag down to Flow.
The command, which is sent, and the received answer, can be monitored in the Communication Monitor Window at the bottom of the screen. If no device response is received during 2 seconds, or an error message is returned from the connected DFC, the program will prompt with a communications error message.

If continuous Flow reading is required, use AutoSingle for single device or AutoMulti for multiple devices in the system (RS-485 interface only). 

Sending Set Point to the Device

The Commands/SetPoint menu selection is used to tell the DFC to receive once a new set point. Before attempting to send a set point to the device, the correct device number has to be chosen from the Current Device combo box.

m Make sure the input mode is Digital and the valve is in the Auto mode before attempting to send a set point to the device. Use Commands/Mode/Digital and Commands/Valve/Auto to make corresponding settings.

To Send Set Point Once: 

1. Point to the Commands menu and drag down to SetPoint.

2. Transmit Set Point Dialog box will appear. Enter the desired set point value in the current Engineering Unit and press ENTER or click the OK button. 

Device should respond with “!XX,S##.##” in the Received text box of the Communication Monitor. Where:

!XX – start character and two characters for the address  (this is only applicable for RS-485 interface);

            ##.## - new set point value (25.00 for example).               

If no device response is received during 2 seconds or an error message is returned from the connected DFC, the program will prompt with a communications error message. A set point also can be sent in the AutoSingle mode for single device or AutoMulti mode for multiple devices in the system (RS-485 interface only). 

Monitoring Device Continuously

The Commands/AutoSingle menu selection is used to provide continuous transmission of the Read Flow command with the selected interval time (Sampling Interval), and provide the opportunity to increment / decrement the value of the set point with the horizontal scroll bar or typing the new value of the set point into the Set Point text box. The solenoid valve of the DFC can be set to ether: Closed, Auto or Open. Additionally this mode provides capability to save data (flow rate in current engineering units) in to user-define file (AutoLogFile) on the host computer disk with the selected interval time (Log Recording Interval). Within AutoSingle mode all functions of the Totalizer and Alarm are available. AutoSingle mode is recommended to be used with single device systems like RS-232 interface, however, operating with one device in the RS-485 system is also possible. 

To Start AutoSingle Mode:

Click to the Commands menu and drag down to AutoSingle… 


Or

Click AutoSingle Icon on the toolbar.

Device Frame will appear with Flow Display and Set Point scroll bar. The number of the device will appear in the upper left corner of the Device Frame. A short functional description of the device is located in the text box, next to the device number.

The data on the Flow Display will be displayed in engineering units, which you configured in the device properties for the particular device. The Set Point window displays set points in the same engineering units. A set point can be changed: by scrolling the pointer in the horizontal scroll bar, and for more precise adjustment, by clicking on left and right arrows (decrement / increment set point by 0.1% of F.S.).  

To Stop AutoSingle Mode:

Click to the Commands menu and drag down to AutoSingle… 


Or

Click AutoSingle Icon on the toolbar.

Recording data to Disk

 The AutoLog file has to be open in advance in order to record data in to the file within AutoSingle mode.   

.

To Open AutoLog File:                  

1. Click to the File menu and drag down to Open AutoLog File…
               OR

              Click Open the AutoLog File Icon on the toolbar. 

 2.  It displays the Open dialog window, where you specify a file name.     Enter the desired name and close the dialog window by clicking OPEN.  

After you opened the AutoLog File, you are ready to record data within the AutoSingle mode.

To begin Data Recording:


Click to the Device menu, drag down to Recorder and click Start   


OR


Click the StartRecorder Icon on the toolbar. 

Data will be recorded to the file with the interval specified in the Log Recording Interval properties. Data acquisition to disk may be started and stopped as many times as desired.

If the AutoLog file is not opened, then the StartRecorder menu and icon will be disabled.

To stop Data Recording: 


Click to the Device menu, drag down to Recorder and click Stop  


OR


Click the StopRecorder Icon on the toolbar.

If it is necessary to start data acquisition into a different file: stop the Data Recording, stop the AutoSingle mode and close the existing AutoLog file.

To Close the AutoLog File:

Click to the File menu and drag down to Close AutoLog File…

OR

               Click the Close AutoLog File Icon on the toolbar.

After this you will be able to open a new AutoLog File and start the AutoSingle mode.

Using Alarm Feature

Alarm is available only in the AutoSingle mode. Before enabling Alarm make sure all alarm settings are configured properly. High and Low alarm values have to be entered in %F.S. engineering units for corresponding devices. ALARM conditions become valid when the difference between current readings and installed set points is equal or more than corresponding values of high and low alarm levels. Alarm function acquires status of the Alarm with the update rate set in Alarm Properties. Default setting is one second.  

To modify Alarm properties: 


1. Click to the Device menu and drag down to Properties…

2. Click on the ALARM tab.

3. Enter the desired parameters in the Device Properties Alarm dialog box.


4. Click the OK button.

If the AlarmLog File is opened all ALARM events will be saved in the file including alarm readings and the time when the alarm occurred.

To Open the AlarmLog File: 

1. Click to the File menu and drag down to Open AlarmLog File…
2. It displays the Open dialog window, where you specify a filename.       Enter the desired name and close the dialog window by clicking OPEN.  

During Auto Single mode the Alarm function may be enabled and disabled as many times as desired by clicking on the ALARM On/Off button in the device window.

Using The Totalizer Feature

Totalizer is available only in the AutoSingle mode. Before enabling the Totalizer make sure that all properties settings are configured properly. The “Start at Flow” value has to be entered in  %F.S. engineering units for corresponding devices. The “Stop at Total” value has to be entered in volume related units for corresponding devices. For example if the engineering unit for a device is SLPM, the “Stop at Total” value has to be entered in Liters. Totalizer conditions become truth, when calculated volumes and “Stop at Total” volumes are equal. 

When the “Start at Flow” feature is not desirable, the value of the “Start at Flow” must be installed to 0.00. At this point the totalizer function will produce calculation of total, always, without checking flow rate readings.

To modify Totalizer properties:


1. Click to the Device menu and drag down to Properties…

2. Click on the Totalizer tab.

3. Enter the desired parameters in the Device Properties Totalizer dialog box.


4. Click the OK button. 

The Totalizer function may be enabled or disabled as many times as desired by clicking on the Totalizer On/Off button in the device window. Click on the RESET button in order to reset the Totalizer to zero.

Monitoring Multiple Devices Continuously (RS-485) 

The Commands/AutoMulti menu selection is used to provide continuous transmission of the Read Flow and Set Point commands with the selected interval time (Sampling Interval), for all enabled devices in the system. The Set Point control provide the opportunity to increment / decrement values of the set point with the horizontal scroll bar, or typing a new value of the set point in to the Set Point text box. Additionally this mode provides capability to save data (flow rate in current engineering units) into a user-defined file (AutoLogFile) on the host computer disk with the selected interval time (Log Recording Interval). In the AutoMulti mode, the user can choose different layouts of the screen configuration with four or eight device windows.

To Start AutoMulti Mode: 

Click to the Commands menu and drag down to AutoMalti… 


Or

Click the AutoMulti Icon on the toolbar.

To Change the Layout of the Screen:

Click to the Device menu and drag down to View…and select Four or Eight devices.

Executing a Custom Program

The Commands/Program Mode menu selection is used to provide the opportunity to execute up to 12 step user defined programs. Programs can be executed only with a currently active device. Before executing, the program should be entered in the program table in the format: SETPOINT [current Eng. Unit] - TIME [sec.]. TIME means: time it takes for the value of the output signal from DFC to linearly approach SETPOINT (ramping). During the execution of the program the Host computer generates and sends ASCII commands that produce linearly rising or falling ramps (depending of the program) signal output. 

To Start Program Mode:

1.   Click to the Commands menu and drag down to Program Mode…
This displays the Program Data Setting window. This is where you enter the Set Point and Time values. Enter the desired values, check “Loop box” if you require continuous execution of the program in the loop mode.

2.    Click to the Save button. It displays the Open dialog window, where you specify a file name. Enter the desired name and close the dialog window by clicking OPEN.  

3.    Click [Run] button to start program execution.  

During execution of the program the user can activate or deactivate LOOP mode by clicking on the LOOP check box. Click on the Quit button to stop program execution.

A previously saved program can be loaded for execution.

To Load a Program:

1. Click to the Commands menu and drag down to Program Mode…
This displays the Program Data Setting window.

2. Click to the Load button. It displays the Open dialog window, where you specify a file name. Enter the desired name and close the dialog window by clicking OPEN. 

3. Click to the Run button. 

If LOOP mode is checked the program will run in the loop until you press Quit button.

If AutoLog File is open, the flow recorder is available in the Program mode.

Using Terminal Window

 The Terminal mode feature is intended to simulate a dumb terminal. In terminal mode each key depressed on the keyboard is immediately transmitted through the selected communications port at the selected baud rate. The RS-232 Request To Send (RTS) signal is supported and will become active (high) while each character is transmitted.

To Start Terminal:

Click to the CommPort menu, drag down to the Terminal and click to the Start…

This displays the Terminal window. If the Log File is opened, all terminal activities (received and sent characters) will be saved in the log file and can be viewed with any text editor. 

To Open the Log File:

1. Click to the File menu and drag down to Open Log File…
2. It displays the Open dialog window, where you specify a file name.                                  Enter the desired name and close the dialog window by clicking OPEN.  

To Stop the Terminal:

Click to the Terminal menu, drag down and click to the Stop…

Options Routines

The Options menu selections provide the opportunity to: 

· Change Engineering Units

· Change Current Gas table

· Control Alarm and Totalizer

· Assign Action for Relay#1 and Relay#2

· Change internal or user specified K Factor  

· Read and Reset DFC’s Pilot Timer

Query Routines

The Query Routines are intended mostly for debugging and troubleshooting.  Normally users should not use them. 

m  Be extremely careful with the MEMORY/ WRITE function.  Improper using of the Memory/Write function may cause the unit to malfunction. 

Use Query/BackDoor/Open in order to get access to EEPROM memory and ADC/DAC data. It is recommended to execute Query/BackDoor/Close after any operation with EEPROM memory in order to prevent accidental data corruption.

Tools Routines  

The Tools menu selection is used to:

- Set Span and gain jumpers.                                                                                           

- Calibrate ADC and DAC.                                                                                            - - Perform Close Loop gas calibration 

- Set up Valve Linearization Table   

- Edit the contest of the Gas Dependent Variables 

      -  Export and Import EEPROM data  

      -  Perform PID Auto Tune procedure  

      - Perform Manual Zero Adjustment

 m  Each  DFC module,  shipped from the factory is pre-calibrated  and  programmed for a particular Gas with a specified inlet pressure. Each DFC contains its own unique calibration constants stored in the EEPROM memory. Usually, it is not necessary to perform a calibration except if the user wants to add additional Gas calibration tables. Be extremely careful with Tools functions.  Always check the number of the current Gas table before  performing actual Close Loop calibrations.  
